
Description
This tutorial illustrates a very common use of EDSMAC4, that is, to perform a
time-distance study to evaluate accident avoidability.

Using HVE to execute this event further illustrates the power of visualization:
While the EDSMAC4 event tells us the time available to avoid a crash, the
visualization actually shows us. The capability to visualize is inherent to any
HVE simulation.

This tutorial is a continuation of the EDCRASH Tutorial, wherein the initial
vehicle velocities were estimated. You may wish to review that tutorial before
continuing.

Like all EDSMAC4 events, the procedure involves the following basic steps:

� Create the vehicle(s)

� Create the environment

� Execute the EDSMAC4 event

� Review the EDSMAC4 output reports

This basic procedure is described in detail in this tutorial.
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Getting Started
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As in other tutorials, before we get started with our current tutorial, let’s set the
user options so we’re all starting on the same page.
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To set the initial user options, choose the following from the Options Menu:

� ON: Show Key Results

� OFF: Show Axes

� ON: Show Contacts

� OFF: Show Velocity Vectors

� ON: Show Skidmarks

� OFF: Show Targets

� ON: AutoPosition

� Units equals S.I.
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� Render Options:

� Show Humans as Actual

� Show Vehicles as Actual

� Phong Render Method

� Complexity equals Object

� Render Quality equals 5

� Texture Quality equals 1

� Anti-aliasing equals 1

The remaining options will automatically initialize to their default conditions.
We’re now ready to proceed with the tutorial.

Creating the Vehicles
Let’s add the vehicles to our case. The first vehicle is a white, 1996 Ford Escort
2-Door Hatchback; the second vehicle is a dark red 1995 Nissan Sentra 4-door
Sedan. Let’s add the first vehicle:

� If the Vehicle Editor is not the current editor, choose Vehicle

Mode. The Vehicle Editor is displayed.

� Click Add New Object. The Vehicle Information dialog is

displayed. The Vehicle Information dialog allows the user to

select the basic vehicle attributes according to Type, Make,

Model, Year and Body Style.
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� Using the option buttons, click each button to choose the

following vehicle from the database:

� Type = Passenger Car

� Make = Ford

� Model = Escort

� Year = 1991-1996

� Body Style = 2-Door Hatchback

� Driver Location = Right

� Click OK to add Ford Escort 2-Dr Hatchback to the Active

Vehicles list.
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The Ford Escort is added to the case. Next, let’s add the Nissan Sentra.

� Click Add New Object. The Vehicle Information dialog is

displayed.

� Using the option buttons, click each button to choose the

following vehicle from the database:

� Type = Passenger Car

� Make = Nissan

� Model = Sentra

� Year = 1995-1999

� Body Style = 4-Door

� Driver Location = Right

� Click OK to add Nissan Sentra 4-Dr to the Active Vehicles list.

We now have the vehicles required for our study, as shown in Figure 5-1.

Editing the Vehicles

Next, we’ll edit the vehicles to change their color and weight. In addition, we’ll
change the stiffness of the Nissan Sentra, using values derived from our initial
reconstruction analysis.

Start by changing the color of the Ford Escort:

� Select the Ford Escort 2-Dr Hatchback from the Active

Vehicles drop-down list, making it the current vehicle. The

Ford Escort is now displayed in the Vehicle Editor.
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� Click on the CG and choose Color. The Vehicle Color dialog is

displayed (see Figure 5-2), showing the vehicle’s current color

(the small black square, or hot spot, in the color wheel) and

intensity (the arrow in the intensity slider). Click on the hot spot

and drag it to the center of the circle. To lighten the vehicle, click

on the intensity slider and drag it to the far right end.
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� When the color is to your liking, press the Close button to

apply the new vehicle color.
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Next, let’s change the Escort’s weight. Perform the following steps:

� Click on the CG and choose Inertias. The Inertias dialog is

displayed (see Figure 5-3), and we’re ready to change the

vehicle’s weight.
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� In the Total Weight text field, replace the existing weight,

10283Newtons, with the measured value,11037Newtons.

� ����� ��� ������ �� ������
 	� 	 ����� 6�������7! $	��


���� 6.�7 	�� �	��
�	��
 	�
 
����	(�
!

� ����� ��� 
�	��� ����� 
����	( ,:�;9!+� �� �����	�

�
���� ���	
�� ��� ������ �� 	��
	��( 
� �
�
 �( ���

�
����� ��	 ��( �����	�� 	�
 �����
 	� �	��! �"��	

��������� ���
��� ���� ��� �	�� �� �
�������
 �( ���

�
����� ��	 ��( �����	�� 	�
 ��
����	(�
!

� Press OK to accept the weight value.

The Ford Escort is now ready for use in our tutorial. Using the viewer thumb
wheels and/or manipulators, pan, zoom and look at the vehicle.

Note that, in HVE, the thumb wheels rotate the vehicle about the viewer axes,
not the vehicle axes.
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Now, let’s change the color, weight and stiffness of the Nissan Sentra:

� Click on Nissan Sentra 4-Dr in the Active Vehicles list,

making it the current vehicle. The Nissan Sentra is now

displayed in the Vehicle Editor.

� Click on the CG and choose Color. The Vehicle Color dialog is

displayed. The vehicle’s color is fine, but we need to darken it.

To darken the vehicle, click on the intensity slider and drag it to

the middle of the range.
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� When the color is to your liking, press the OK button to apply

the new vehicle color.

Next, let’s change the Nissan’s weight:

� Click on the CG and choose Inertias. The Inertias dialog is

displayed.
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� In the Total Weight text field, replace the existing weight,

10858Newtons, with the measured value,11282 Newtons.
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� Press OK to accept the weight value.

Finally, let’s change the stiffness of the vehicle. From a previous
reconstruction analysis, the A and B stiffnesses were re-calculated in order
to balance the forces (the technique is described in references [20] and
[21]). Based on this analysis, let’s enter the new values:

� Click on the right side surface icon (red sphere). The CG to

Right Side dialog is displayed.

� Click Stiffness. The Stiffness Coefficients dialog for the right

side surface is displayed, as shown in Figure 5-4 on the

following page.

To edit the current A and B stiffness values:

� In the A Stiffness field, replace the current value, 175.1, with

the calculated value, 833 N/cm.

� In the B Stiffness field, replace the current value, 45.6, with

the calculated value, 170 N/cm
�
.

� Click OK to update the stiffness.

� Click OK again to remove the CG to Right Side dialog.

The Nissan Sentra is now ready for use in our tutorial. Using the viewer
controls (thumb wheels and manipulators), view the vehicle.

Now, we have both vehicles ready for our study.

� � !

������� �����	
� ��� ���	����

������ ��& ������� #�������� ��
���� ���� ��� ������� ��� ������� %� ' 
��
(� ��������� ������������ ��� ��� ������� ����
��� )��� ��
� !"#$%�&
���� ��� % 
�� ' ��������� ��� ��� �������� ����
��* �
�����  ����
+� ����

 ������ 

��� �� (� ��� ��� ������ 
�������



Saving the Case
Now that we’ve created vehicles for our case, let’s save the case file.

� Click on the File menu and choose Save. The Save-as File

Selection dialog is displayed.
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� In the Case Title text field, enter EDSMAC4 Tutorial,

Visibility Study.
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� In the Filename text field, enter Edsmac4Tutorial.

� Click SAVE. The current case data are saved in the

hve2d/supportFiles/case subdirectory.
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Creating the Environment
Now, let’s add the environment:

� Choose Environment Mode. The Environment Editor is

displayed.

� Click on Add New Object. The Environment Information

dialog is displayed.

� Using the Location Database combo box, choose Sydney,

NSW, Australia. The latitude (35.30.00S), longitude

(151.10.00E) and GMT, hours from the prime meridian (+10)

are displayed for the selected location.
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� Edit the name for the accident site, Blind

Intersection.

� Edit the date and time of the incident we are studying,

7-23-97 and 1330, respectively.

� Edit the angle from true north to the earth-fixed X axis in our

environment, -10 degrees.
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� To add the environment geometry file to our case, click on

Open. The Environment Geometry File Selection dialog is

displayed.

� The File Format option list will default to h3d Files. A list of

environment geometry files using the .h3d file format is

displayed in the listbox.

� Double-click on EdcrashEdsmacTutorial_2D.h3d to choose

the environment file and remove the dialog.
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� Press OK.
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The selected environment is added to our case and displayed in the
Environment Viewer (see Figure 5-5). Use the viewer thumb wheels to view
the scene.

Creating Events
Asmentionedat theoutset, thisEDSMAC4tutorial is anavoidability study inwhich
visibility plays a key role. With this in mind, we will start simulating the event well
before impact to illustrate the visibility between vehicles, as obstructed by the
building on the southwest corner of the intersection.

To create the event, perform the following steps:

� Choose Event Mode. The Event Editor is displayed.

� Click on Add New Object. The Event Information dialog is

displayed.

� Select Ford Escort 2-Dr Hatchback and Nissan Sentra 4-Dr

from the Active Vehicles list. The vehicles are added to the

Event Humans and Vehicles list.

� Select EDSMAC4 from the Calculation Method options list.

� Enter a name for the event, Visibility Study.
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� Press OK to display the event editor.

Now, we’re ready to set up the event. This step involves placing the vehicles in
the environment and assigning driver controls:

� Select Ford Escort 2-Dr Hatchback from the Event Humans &

Vehicles list.

� Choose Set-up from the menu bar, select Position/Velocity.

The Escort is displayed in its initial position at the earth-fixed

origin.

� Click on the vehicle’s X-Y manipulator (see Figure 5-6), wait

for it to turn bright yellow (indicating it has been selected), and

drag it to its initial position, X=35m, Y=15m. Click the Yaw

field in the Position/Velocity dialog to replace the existing

value with the heading angle, 180 degrees.
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� Click the Velocity Is Assigned checkbox. Enter the initial total

velocity, 40 km/h, followed by Apply (or simply press

<Enter>).
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Next, let’s enter the driver controls:

� Choose Set-up from the menu bar, select Driver Controls. The
Driver controls dialog is displayed. The default driver control
table, Steering, is also displayed for editing.
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� Enter the values shown in Table 5-1 into the steer table:

Next, let’s assign the Brake Table for the Ford Escort:

� Click the Brake tab on the Driver Controls dialog. The Brake
dialog is displayed for the Ford Escort.
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Enter the Escort’s brake table using the Available Friction (default) method:

� � ��

������� �����	
� �#�
��

Time
(sec)

Steer Angle at Steering Wheel
(degrees)

1.50 0.0

2.00 90.0
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Time
(sec)

Available Friction (%/100)

R/F L/F R/R L/R

2.25 0.00 0.00 0.00 0.00

2.35 1.00 1.00 1.00 1.00

2.70 1.00 1.00 1.00 1.00

2.80 1.00 1.00 0.01 0.01
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� Enter the values shown in Table 5-2 into the table:

� Click OK to accept the Ford Escort’s steering and brake tables.

Event set-up for the Ford Escort is now complete. Let’s set up the Nissan
Sentra:

� Select the Nissan Sentra from the Event Humans and Vehicles

list.

� Choose Set-up from the menu bar, select Position/Velocity.

The Nissan is displayed at its initial position at the earth-fixed

origin.

� Click on the vehicle’s X-Y manipulator (see Figure 5-7), wait for
it to turn bright yellow (indicating it has been selected), and drag it
to its initial position, X=3.5m, Y=39m. In the Yaw field in the
Position/Velocity dialog, replace the existing value with the
heading angle, -90 degrees.
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� Click the Velocity is Assigned check box and enter the initial

velocity, 35 km/h, followed by <Enter>.
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The Nissan’s initial position and velocity are now established. Let’s enter the
driver controls. In this case, there are no driver inputs, per se. However, after
impact the vehicle coasts to rest, so we need to enter rolling resistances:

� Choose Set-up from the menu bar, and select Driver Controls.
The Driver Controls dialog is displayed.

� Click the Brake tab. The Brake Table is displayed.

� Click on the Table Is option list and choose the Available
Friction option.

� Enter the rolling resistances after impact, as shown in Table

5-3, below:

� Press OK to accept the table.

This event lasts more than 5 seconds. To prevent premature termination, let’s
increase the default maximum simulation time.

� Click on the Options menu and choose Simulation Controls.
The Simulation Controls dialog is displayed.

� Edit the Maximum Simulation Time, changing it from 5 to 10

seconds.

� Press OK to update the simulation controls.

Now, we’re ready to execute the event. But first, because the issue is
avoidability, let’s view the sequence from several locations, including from
within the vehicles, to determine what the event was actually like for each driver.

Setting the View

Both HVE-2D and HVE allow the user to position the camera anywhere within
the environment and to attach the camera to any object in the event. HVE has
additional features that we will use in this visibility study to get a driver’s view
of the event. Therefore, while this section of the manual is of interest to both
HVE and HVE-2D users, it is written primarily for users of HVE.
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Time
(sec)

Available Friction (%/100)

R/F L/F R/R L/R

2.70 0.00 0.00 0.00 0.00

2.80 0.20 0.20 0.01 0.01
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Let’s first view the sequence from a good overall vantage point, such as is
displayed in Figure 5-8:

� Use the viewer controls (thumb wheels, zoom slider and direct
hand-in-viewer manipulator) to set the view similar to that
shown in Figure 5-8.

Next, let’s set up the Key Results windows:

� If Key Results windows are not displayed, choose Show Key

Results from the Options menu.

� Drag the Key Results windows to a convenient location, where

they do not block the view but still allow us access to the

viewer thumb wheel controls (in case we want to change the

view).

Now, we’re ready to execute the event.

� Using the Event Controller, press Play to execute the event.

Watch as the vehicles approach each other, collide, and roll to their rest
positions.
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In HVE, note that the Nissan climbs the curb just before coming to rest.

Now, let’s replay the sequence as viewed by the driver of the Ford Escort.

� Using the Event Controller, press Rewind.

A very useful feature of HVE is the ability to simulate the driver’s view by
attaching the camera to the vehicle in the position of the driver’s head and
facing in the direction of the driver’s sight. In HVE-2D, the camera may be
also be attached to any vehicle, but the view remains straight down,
“helicopter” view.

Let’s attach the camera to the Ford.

� Choose Set Camera from the View menu. The Camera dialog

is displayed (see Figure 5-9).

� Click on the View From option list. The list displays each

object in the event (Blind Intersection, Ford Escort 2-Dr

Hatchback and Nissan Sentra 4-Dr; see Figure 5-9).

� Choose Ford Escort 2-Dr Hatchback from the View From

option list.

� Enter the Camera coordinates, x = 0.0m, y = 0.5m, z =

-0.6 m.
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� Enter the Picture Center coordinates, x = 10.0 m, y = -2.5

m, z = -0.6 m.

� ����� ����� ����
��	��� 	�� 	��� ���	�� � �� ��� 0��


������� 	�
 
����� 	  ��� 	���� ���.��� ����	�
 	�
 ��

��� ����� 	� ����� �� 0��
�� +�,:!

� �� ������� ���  ��� �� ���������
 �� ��� ���	���� 
����

2����������3  ���� �� ����� 	�� �� /���
�� &�����

����
��	���!

� � �"

�����	
� �#�
�� �����	��

(0,0.5,-0.6)

(10.0,10.0,-0.6)(10.0,-2.5,-0.6)

X

Y

������ ���7 "�
��
+ ����� ��� ���
������� ������� ��� �
+��

 ������� 
��  ������ ������ �������
����

T
U

T
O

R
IA

L



� Press OK to assign the new camera position.

The viewer now shows the scene as viewed from the Ford Escort. Now we’re
ready to see how the accident occurred from the Ford driver’s perspective.

� Press Play to view the accident sequence from the Ford

driver’s perspective.

Watch as the Nissan becomes visible at t=1.2 seconds, as shown in Figure
5-11. Noting from the steer table that the Ford’s driver began steering at t=1.5
seconds and began braking at t = 2.25 seconds, we can draw some conclusions
regarding the driver’s perception/reaction time.

Allow the event to run to completion.

Next, we can repeat the above steps for the driver of the Nissan Sentra.

� Choose Set Camera from the View menu. The Camera dialog

is displayed.

� Click on the View From option list and choose Nissan Sentra

4-Dr.

� The Camera coordinates for the Ford Escort are acceptable for

the Nissan as well.

� Enter the Picture Center coordinates, x = 10.0m, y = 10.0

m, z = -0.6 m.
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� Press OK to assign the new camera position.

Now we’re ready to see how the accident occurred from the Nissan Driver’s
perspective.

� Press Play to view the accident sequence from the Nissan

driver’s perspective.

Watch as the Ford becomes visible at t=1.3 seconds, as shown in Figure 5-12.
Because there was no pre-impact skidding of the Nissan, we cannot draw any
conclusions regarding the Nissan driver’s perception/reaction time (other than
there was a lack of driver response).

� Allow the event to run to completion.

You may wish to view the sequence from other perspectives. Use the viewer
controls or the Set Camera dialog to adjust the view.
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If you have not already done so, execute the event:

� Using the event Controller, press Play to execute the event.

Allow the event to run to completion.
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While it is not possible to set the camera to a driver’s perspective in HVE-2D
(by definition a 3-dimensional operation),you can use the helicopter view to
determine line of sight at each timestep.

We have now completed the event.
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Viewing Results
Now that we have produced our EDSMAC4 simulations, let’s take a detailed
look at the results. The Playback Editor is used for reviewing and printing
reports for each event in the current case, as well as for producing video output.

EDSMAC4 produces the following reports:

� �������� ����	
� � A table of initial, impact, separation and final

positions and velocities for each vehicle

� 
����� 
��� � A table of damage profile coordinates, CDC, PDOF,

Delta-V and Peak Acceleration for each vehicle

� 
������
	����� - A 3-D visualization of the damage to each vehicle,

linked to the Playback Controller

� 

���
 
��� - Tables of driver input to each vehicle

� ����
	�����
��� - A list of physical environment variables used by

the simulation

� ����� 
��� - A list of event-related activities such as tire blowouts or

wheel displacements during the current run

� �������� - A list of messages produced by the current run
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� �
	�
�� 
��� � A table containing program control information

� ������� 
��� � A series of tables containing the vehicle data used for

each vehicle

� �
�����	
� ��������	� � A 3-D visualization of the event, displayed

at a user-selectable time interval

� ��
����������� �A table containing user-selectable, time-dependent

simulation results for each vehicle

� ������� 
��� - Tables containing all of the vehicle data used by the

simulation

To view the output reports, we need to be in Playback mode:

� Choose Playback Mode. The Playback Editor is displayed.

Report Windows

The reports listed on the previous page are displayed by selecting Report
Windows. Each Report Window contains an individual report.

To view the reports produced by the EDSMAC4, Visibility Study event,
perform the following steps:

� Choose Playback Mode. The Playback Editor is displayed.

� Click Add New Object. The Report Window Information

dialog is displayed, as shown in Figure 5-13, and includes a list

of the active events (EDSMAC4, Visibility Study is the only

event in this tutorial). The Report Window Information dialog

also includes the user-editable Report Window Name text field

and Selected Output option list.

� Select EDSMAC4, Visibility Study from the Active Events list.

� Click on the Select Output option list and choose any of the

available reports.

� Press OK to display the report.

The selected report will be displayed in a resizable window. The following
pages illustrate the reports produced for the EDSMAC4, Visibility Study event.
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Accident History

The Accident History report displays the positions and velocities for each
vehicle at key times (Start of Run, Impact, Separation and Final/Rest) during
the run.

To view the Accident History report for the EDSMAC4 Visibility Study event,
perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDSMAC4, Visibility Study from the Active Events list.

� Click on the Select Output option list and choose Accident

History.

� Press OK.

The Accident History report is displayed for the EDSMAC4, Visibility Study
event, as shown in Figure 5-14.
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Damage Data

The Damage Data report displays a table of collision vector results for each
vehicle. The collision vectors determine the total force on each vehicle. In
addition, the endpoints of the collision vectors define the damage profile.

The collision vectors are displayed both in cylindrical coordinates (RHO, PSI)
and Cartesian coordinates (x,y).

Following the table of collision vectors, the Damage Ranges are displayed.
The Damage Ranges report includes the beginning and ending point for each
damaged region on the exterior (up to 10 regions may be displayed for each
vehicle), followed by the CDC, PDOF, Delta-V and Peak Acceleration for
each damage region.
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To view the Damage Data report for the EDSMAC4 Visibility Study event,
perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDSMAC4, Visibility Study from the Active Events list.

� Click on the Select Output option list and choose Damage

Data.

� Press OK.

The Damage Data report is displayed for the EDSMAC4, Visibility Study
event, as shown in Figure 5-15.
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Damage Profiles

The Damage Profiles report provides a 3-D visual representation of the
damage to each vehicle. This report is linked to the Playback Controller
through the Trajectory Simulation. Therefore, in order to see any damage in
the Damage Profiles report window, you must first open a Trajectory
Simulation for the event.

To view the Damage Profiles report produced by the EDSMAC4, Visibility
Study event, perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDSMAC4, Visibility Study from the Active Events list.

� Click on the Select Output option list and choose Damage

Profiles.

� Press OK.

With a Trajectory Simulation also open, use the Playback Controller to view
the damage to each vehicle dynamically.

The Damage Profiles simulation for the Nissan Sentra in EDSMAC4, Visibility
Study is shown in Figure 5-16.
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Driver Data

All driver input that was entered in the Event Editor is reported in the Driver
Data output report.

To view the Driver Data report produced by the EDSMAC4, Visibility Study
event, perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDSMAC4, Visibility Study from the Active Events list.

� Click on the Select Output option list and choose Driver Data.

� Press OK.
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Environment Data

The Environment Data output report gives the values of the physical
environment variables used by the simulation.

To view the Environment Data report produced by the EDSMAC4, Visibility
Study event, perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDSMAC4, Visibility Study from the Active Events list.

� Click on the Select Output option list and choose Environment

Data.

� Press OK.
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Event Data

Event-related activities such as wheel displacements or tire blowouts are
reported in the Event Data report.

To view the Event Data report produced by the EDSMAC4, Visibility Study
event, perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDSMAC4, Visibility Study from the Active Events list.

� Click on the Select Output option list and choose Event Data.

� Press OK.
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Messages

EDSMAC4 produces several messages, depending on the outcome of the run.
For a complete list and explanation of these messages, refer to Chapter 6.

To view the Messages report produced by the EDSMAC4, Visibility Study
event, perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDSMAC4, Visibility Study from the Active Events list.

� Click on the Select Output option list and choose Messages.

� Press OK.
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Program Data

The Program Data report displays the simulation controls (integration time
steps and termination conditions), collision parameters used by the
EDSMAC4 collision algorithm and the hard-coded values (RHOB Tests) used
to determine if a vector passes through the end (front or back) or side (left or
right).

To view the Program Data report for the EDSMAC4, Visibility Study event,
perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDSMAC4, Visibility Study from the Active Events list.

� Click on the Select Output option list and choose Program

Data.

� Press OK.

The Program Data report is displayed for the EDSMAC4, Visibility Study
event, as shown in Figure 5-21.
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Trajectory Simulation

The Trajectory Simulation report is a dynamic visualization, much like the
Event mode viewer, controlled by the Event Controller.
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To view the Trajectory Simulation for the EDSMAC4, Visibility Study event,
perform the following steps:

� Click Add New Object. The Report Window Information
dialog is displayed.

� Select EDSMAC4, Visibility Study from the Active Events list.

� Click on the Select Output option list and choose Trajectory
Simulation.

� Press OK.

The Trajectory Simulation viewer is displayed for the EDSMAC4, Visibility
Study event. The vehicles are shown at their initial positions.

During Event mode, HVE users changed the camera’s View From position to
the Nissan. The Playback Editor inherits the camera position from Event
mode, so it’s still attached to the Nissan. Before we view the trajectory
simulation, we will change the view back to the environment:

� Choose Set Camera from the View menu. The Camera dialog
is displayed.

� Click on the View From option list and choose Blind
Intersection.

� Enter the desired camera coordinates, X =50.0m, Y =10.0m,
Z = -3.5 m.

� Enter the desired picture center coordinates, X = 0.0m, Y
= 8.0 m, Z = 0.0 m.

� Press OK to update the camera position.

The view is now looking down the street, as shown in Figure 5-22.

To visualize the motion, perform the following steps:

� Click Play (single right-arrow). The simulation begins and is
displayed at the current Playback output interval.

� Click Pause. The simulation stops.

� Click Reverse (single left-arrow). The simulation plays in
reverse.

� Click Pause. The simulation stops.

� Click Rewind (left arrow with bar). The simulation returns to
the start.

� Click Advance to End (right arrow with bar) the simulation

advances to the end of the run.
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Variable Output

The Variable Output table displays all the time-dependent results computed by
EDSMAC4. To view the Variable Output report for the EDSMAC4, Visibility
Study event, perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDSMAC4, Visibility Study from the Active Events list.

� Click on the Select Output option list and choose Variable

Output.

� Press OK.

The Variable Output report is displayed for the EDSMAC4, Visibility Study
event. The next step is to select the time-dependent results we wish to display
in the table.

Variable Selection

The purpose of our EDSMAC4 study is to evaluate the avoidability of the
accident based on speeds and visibility. To document the path positions as a
function of time, let’s select the position, velocity and acceleration from the
Variable Selection dialog.

� Click on Select Variables in the Variable Output window. The

Variable Selection dialog is displayed, as shown in Figure 5-23

on the following page.

The Object Name option list displays the first vehicle, Ford Escort 2-Dr
Hatchback. The Kinematics output group is the default selection and the
Kinematics Variables list is displayed. Let’s add X, Y, Yaw, V����� and Accel
total to the Key Results window:

� Select X, Y, Yaw, V-tot and Acc-tot from the list .

Next, let add the same parameters for the Nissan Sentra:

� Click on the Object Name option list and choose Nissan Sentra

4-Dr. The Kinematics variable list is displayed.

� Select X, Y, Yaw, V-tot and Acc-tot from the list .
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� Press OK to add the selected variables to the Variable Output

window.
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The Variable Output report for the EDSMAC4, Visibility Study event now
includes position, velocity and acceleration for both vehicles, plus any
other variables you may have added (see Figure 5-24).
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Vehicle Data

The Vehicle Data report displays the vehicle data, tire data and driver tables for
each vehicle in the event.
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To view the Vehicle Data report for the EDSMAC4, Visibility Study event,
perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDSMAC4, Visibility Study from the Active Events

list.

� Click on the Select Output option list and choose Vehicle Data.

� Press OK.

A portion of the Vehicle Data report is displayed for EDSMAC4, Visibility
Study in Figure 5-25.
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Printing

The final step is to print the above reports. Printing reports is simple. All you do
is choose a report and print it. For example:

� Click on the Variable Output - EDSMAC4, Visibility Study

report window. The window is highlighted and pops to the top

of the display (if it isn’t there already), indicating it is the

current window.

� Click on the File menu and choose Print. The Print dialog is

displayed, allowing the user to select from several available

print options.
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� Press OK. The Variable Output report is printed on the system

printer.

That’s all there is to it! You can print any other report using the same three
steps described above.
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